
Flexify 2 
Flaming Pear Software

What it does

Flexify is a plug-in filter for paint programs. It warps full-sphere photos — 
those showing a full view of a scene in every direction — into new shapes that 
are more attractive or useful. It can also transform maps.

How to install

Illustrated installation instructions are online at www.flamingpear.com/
faq.html .

To use this software, you need a paint program which accepts standard 
Photoshop 3.02 plugins.

Just put the plug-in filter into the folder where your paint program expects to 
find it. If you have Photoshop, the folder is Photoshop:Plugins:Filters or 
Photoshop:Plug-ins. You must restart Photoshop before it will notice the new 
plug-in. It will appear in the menus as Filters->Flaming Pear->Flexify 2.
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Most other paint programs follow a similar scheme.

If you have Paint Shop Pro: you have to create a new folder, put the plug-in filter 
into it, and then tell PSP to look there.

PSP 7:

Choose the menu File-> Preferences-> File Locations... and choose the Plug-in 
Filters tab. Use one of the “Browse” buttons to choose the folder that contains 
the plug-in.

The plug-in is now installed. To use it, open any image and select an area. From 
the menus, choose Effects->Plug-in Filters->Flaming Pear->Flexify 2.

PSP 8, 9, X, XI, X2, X3:

Choose the menu File-> Preferences-> File Locations... In the dialog box that 
appears, choose Plug-ins from the list. Click “Add.” If you are using PSP 8 or 9, 
click “Browse”. Now choose the folder that contains the plug-in.

The plug-in is now installed. To use it, open any image and select an area. From 
the menus, choose Effects->Plugins->Flaming Pear->Flexify 2.

Quick start

When you invoke Flexify 2, a dialog box will appear.
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To get a quick idea of what Flexify does, load a 
full-sphere panoramic image into your paint 
program (there’s a small example panorama here). 
If the image is circular, the selection should graze 
the edge of the circle.

Invoke Flexify, and tell it what kind of input image 
you’re using via the “Input” popup menu. Choose a 
different projection from the Output popup. Click 
the dice button a few times until you see a result 
you like; then click OK.

Flexify’s capabilities and controls are explained 
below.
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Projections 

A projection is a way of unwrapping and warping a spherical surface so that it 
will lie down flat. It’s like making a flat map of the Earth — you have to make a 
choice about how to deform shapes.

Flexify can accept as input spherical panoramas in any of fifteen projections and 
can output them in more than fifty. Some of the projections are practical; some 
are weird and are meant to emphasize the bizarre, vertiginous nature of ultra-
wide-angle photography.

Flexify can output these projections:.

equirectangular

a.k.a. cylindrical 
equidistant or 
plate carrée

The panorama fits into a 
rectangle. Meridians are 
vertical, parallels are 
horizontal, and the north 
and poles are stretched out 
to lines at the top and 
bottom. Scanning panoramic 
cameras produce this kind of 
image. Not the same as 
Mercator.

mirror ball The reflection seen in a 
mirrored ball.

 

polar

a.k.a. azimuthal 
equidistant

Angular distance from the 
center of projection 
increases uniformly toward 
the edge.

4



orthographic The image sphere as seen 
from the outside.

tetrahedron

An unfolded 4-faced shape.

Most of Flexify’s polyhedra 
can be exported as 3D .obj 
files.

cube An unfolded 6-faced shape.

octahedron An unfolded 8-faced shape.

dodecahedron An unfolded 12-faced shape.
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icosahedron An unfolded 20-faced shape.

Hammer A 2:1 wide ellipse.

Werner A heart-shaped projection.

sinusoidal

a.k.a. Sanson-
Flamsteed

A pointy shape.

rectilinear

a.k.a. gnomonic

Like a regular view from a 
normal lens. Straight lines 
stay straight. The FOV slider 
controls the zoom, which can 
go all the way to a 180° field 
of view.
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hyperbolic

Produces views balancing 
naturalness with vertigo. The 
FOV slider controls the 
zoom, which can go all the 
way to a 360° field of view.

 

 

stereographic

Like hyperbolic but with less 
distortion of scale and 
shape. The FOV slider 
controls the zoom.

 

 

cylindrical

This is the format needed for 
some panorama viewers, 
including QuickTime VR. The 
view is infinitely stretched 
toward the top and bottom, 
so the vertical view is 
determined by the 
rectangle’s proportions.

Wetch

An unusual projection with a 
finite height and infinite 
width. The FOV slider 
controls the zoom, which can 
go all the way to a 360° field 
of view.

pinwheel Polar with a swirl.
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lozenge A wide diamond shape with a 
crease at the equator.

square
A square full of creases. 
Good for scenes containing 
lots of straight lines.

curvy

Labrys-like shape with 
limited distortion. It’s the 
central portion of a mirror 
ball projection.

goggles

Goggle-shaped view which 
presents the whole sphere in 
a style like the hyperbolic 
projection, but with less 
extreme size changes.

quasar

Weird projection with inside 
and outside regions bounded 
by a circular black-hole-like 
discontinuity.

14 faces An unfolded cuboctahedron.
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24 faces a An unfolded deltoidal 
icosatetrahedron.

24 faces b An unfolded pentagonal 
icosatetrahedron.

26 faces An unfolded small 
rhombicuboctahedron.

30 faces An unfolded rhombic 
tricontahedron

soccer ball An unfolded truncated 
icosahedron.

32 faces An unfolded 
icosidodecahedron.
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38 faces An unfolded snub cube.

60 faces An unfolded deltoidal 
hexecontehedron.

62 faces An unfolded small 
rhombicosidodecahedron.

Winkel Tripel
A compromise whole-earth 
projection often used by the 
National Geographic Society.

gores: 12 A shape for globemaking.

gores: 24 A shape for globemaking.
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gores:multi

A shape for globemaking. 
The FOV slider lets you 
choose anything from 3 to 
36 gores.

gores: 6/12 A shape for globemaking. 
Shows only half the sphere.

loop The scene repeats endlessly 
toward the horns of the loop.

two circles Each half of the scene gets it 
own hyperbolic projection.

balloon
A popular origami pattern. 
Read “Flexify Origami” for 
folding instructions.
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paperlock

An obscure origami pattern. 
Read “Flexify Origami” for 
folding instructions. Fun to 
write letters on the reverse 
and fold them into 
concealment.

Omnimax The format of Omnimax 
70mm film frames.

spikeball

A tetrahedron 5-compound, 
and Flexify’s most difficult-
to-construct polyhedron. It 
prints out as ten sawtooth 
shapes. Each sawtooth folds 
up into a pair of peaks, and 
you assemble them all to get 
the finished shape.

Because the shape is so 
complex, you should start 
with a very bold, simple 
picture.

brick preview

The image sphere built from 
Lego® bricks. Flexify can 
create building plans for 
these spheres. It’s explained 
in the brick sphere part of 
this guide.

Mollweide A 2:1 wide ellipse with 
parallel lines of latitude.
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icomap

An icosahedron unfolded in a 
way suitable for planetary 
maps in some role-playing 
games.

star 3 A polar-Werner hybrid.

star 5 Another polar-Werner 
hybrid.

magnipolar A polar projection 
emphasizing the center.

swoop
Rectilinear in the center, 
blending to hyperbolic at the 
left and right sides.

13



dodo An unfolded 
dodecadodecahedron.

GID An unfolded great 
icosidodecahedron.

oculus
Rectilinear in the center, 
blending to hyperbolic at the 
top and bottom.

triptych
Three 120° rectilinear views 
side by side. Great for scenes 
with lots of straight lines.

tetraptych

Three 90° rectilinear views 
side by side. Suitable for 
presenting rectangular 
rooms.
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annulus A ring shape. The FOV slider 
controls the size of the hole.

shift lens

Rectilinear with a vertical 
offset controlled by the 
Latitude slider. Good for 
looking up at tall buildings 
while keeping the buildings’ 
edges parallel.

Mercator

For making maps with 
straight loxodromes.

Not the same as 
equirectangular.

umbrella

An 8-gore shape suitable for 
making custom umbrellas. 
The FOV slider sets the 
length of the petals.

tetra tile A tetrahedron unfolded to 
repeat endlessly.
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hyper double The panorama bent to 
appear twice in one picture.

hyper triple
The panorama bent to 
appear three times in one 
picture.

Mercator cross A repeating cross pattern.

Mercator star A repeating six-pointed star 
pattern.

Lagrange A conformal projection in a 
circle.
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rind 1

The image sphere 
unwrapped like the peel from 
an apple. The central ribbon 
makes one pass around the 
sphere.

rind 2 A rind with two passes 
around the sphere.

rind 3 A rind with three passes 
around the sphere.

tunable ellipsoid

Creates twelve gores for an 
ellipsoidal globe. The FOV 
slider controls the ellipsoid’s 
proportions.

0 = 0.5:1 skinny ellipsoid. 
90 = 1:1 sphere. 180 = 2:1 
fat ellipsoid.

Or: aspect ratio = 2 ( ( FOV / 

90)-1) .

tunable egg
Like the tunable ellipsoid, 
except the result is egg-
shaped.
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4 views

Four rectilinear views, rolled 
at random angles, looking 
along a uniformly distributed 
set of directions.

12 views Twelve rectilinear views.

24 views Twenty-four rectilinear 
views.

60 views Sixty rectilinear views.

72 views Seventy-two rectilinear 
views.
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Robinson A modern map projection.

equi tall

An equirectangular view 
stretched to fill the whole 
image. This is the way 
equirectangulars worked in 
Flexify 1.

semistereo Midway between rectilinear 
and stereographic.

thorn A cube unfolded, then 
warped.

Lagrange 3/4
A conformal projection 
intermediate between 
stereographic and Lagrange.
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squoculus Good for de-emphasizing 
the sky.

thorn levo A left-handed version of 
thorn.

unFish

Good for improving fisheye 
pictures of people or 
architecture. Straightens 
verticals and makes 
distortion less objectionable 
over about a 180° field of 
view.

Lagrange plus
A Lagrange projection that 
shows more than 360° 
horizontally.

Adams I A conformal mapping of the 
whole sphere to a square.

20



Adams II A conformal mapping of the 
whole sphere to a square.

trecunx A variant of Peirce quincunx.

quadracunx A variant of Peirce quincunx.

Peirce quincunx

A conformal mapping of the 
whole sphere to a square.

If your input is a world map, 
set Longitude to 90° to get 
the standard Peirce map 
layout.
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sexacunx A variant of Peirce quincunx.

septecunx A variant of Peirce quincunx.

5-star A polygon.

pentagon A polygon.
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Guyou A 2:1 conformal rectangle

3-star
An awkward hexagon; 
actually a star based on a 
triangle.

triangle A polygon.

rhombus 1 Each hemisphere in a 
triangle.
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rhombus 2 Another way to present each 
hemisphere in a triangle.

6-star A snowflake or star of David.

hexagon A polygon.

Lee tetrahedric A less-warped triangular 
layout.
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rectangular tet Lee tetrahedric dissected 
into a rectangle.

2-clover A two-lobed shape; two 
stereographic hemispheres.

3-clover A three-lobed shape.

4-clover A four-lobed shape.
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5-clover A five-lobed shape.

6-clover A six-lobed shape.

pentalene A polygon.

naphthalene A polygon.
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phenathene A polygon.

shuriken A four-armed shape.

cross A conformal shape.

double Guyou A 4:1conformal rectangle.
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wide rect A 2:1conformal rectangle.

semicircle A conformal shape.

ellipse A conformal shape.

Reuleaux 1 One conformal Reuleaux 
triangle.

28



Reuleaux 2 Two conformal Reuleaux 
triangles.

Reuleaux 4 Four conformal Reuleaux 
triangles.

Reuleaux 8
Eight conformal Reuleaux 
triangles. Compare 
Leonardo’s mappamundi.

octreleaux Eight stereographic 
segments.
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zigzag A conformal cube unfolding.

chevron A conformal shape.

monozag A conformal shape.

3-malta A conformal shape.
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4-malta A conformal shape.

5-malta A conformal shape.

6-malta A conformal shape.

Gilbert
The world warped so 
everything appears on one 
side of a sphere.
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stereo twice Two copies of a 
stereographic view.

stereo thrice Three copies of a 
stereographic view.

Adams diamonds The image sphere in two 
squares.

equal-area 
cylinder

An equal-area projection. 
Depending on the 
proportions, this can be 
Lambert (3.141:1), Behrmann 
(2.356:1), Edwards 
37°24’ (1.983:1), Hobo-Dyer 
(1.977:1), Gall-Peters 
(1.571:1), or Edwards 50°52 
(1.251:1).
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quick globe A shaded 3D globe.

equal squarea
A Peirce quincuncial map 
warped into an equal-area 
version.

square fish 1 A square fisheye with strong 
peripheral distortion.

square fish 2
A square fisheye with less 
peripheral distortion and 
straighter verticals.

33



Gilbert globe

The world warped so 
everything appears on one 
side of a sphere. With 3D 
shading.

pointy A conformal shape.

shuriken star A conformal shape.

calyx 3 A conformal shape.
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calyx 4 A conformal shape.

calyx 5 A conformal shape.

calyx 6 A conformal shape.

waffle A conformal shape.
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trident A conformal shape.

astercurve 5 A conformal shape.

astercurve 7 A conformal shape.

astercurve 8 A conformal shape.
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trizag A conformal shape.

shark 3 A conformal shape.

shark 4 A conformal shape.

sunburst A conformal shape.
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2 cylinders
The shape formed by the 
intersection of two cylinders. 
A Steinmetz solid.

3 cylinders
The shape formed by the 
intersection of three 
cylinders. A Steinmetz solid.

Isle of Man A rind with three arms.

shard A conformal shape.
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starburst A conformal shape related to 
sunburst.

3-incurvate A conformal shape.

4-incurvate A conformal shape.

phenyl cross A conformal shape.
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anthracene A conformal shape.

conformal 
dodecahedron

A regular dodecahedron with 
a conformal graticule.

tattoo 1 A sphere dissection.

tattoo 2 A sphere dissection.
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zenith & nadir

Top and bottom cube faces. 
Good for hand-retouching 
the poles of a spherical 
panorama. Later, you can re-
import your changes with the 
zenith-nadir input mode.

horizontal cross

Cube faces in horizontal-
cross form. Good for 
retouching. Later, you can 
re-import your changes with 
the horizontal cross input 
mode. For best results, use 
the PSD export and choose 
4x3 image proportions.

vertical cross

Cube faces in vertical-cross 
form. Good for retouching. 
Later, you can re-import 
your changes with the 
vertical cross input mode. 
For best results, use the PSD 
export and choose 4x3 
image proportions.

thirtysphere
A roughly spherical 
polyhedron with vertices 
every 30°.
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devtet A developable shape made of 
ruled surfaces.

conictet A developable shape made of 
four cones.

geodesic spheres

Flexify can make several 
kinds of Class I geodesic 
spheres. In the output menu, 
geodesic spheres are named 
like this:

Geodesic 4|2 is based on a 
tetrahedron; frequency 2.

Geodesic 8|3 is based on an 
octahedron; frequency 3.

Flexify has all the Class I 
geodesic spheres from 4|2 
up to 12|5. Plain Platonic 
solids like 4|1 appear 
elsewhere in the menu.
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sphericons

Sphericons are developable 
3D shapes created by 
making a regular polygon 
into a surface of revolution, 
then twisting one half 
relative to the other.

In Flexify’s output menu, the 
sphericons are named like 
this:

Sphericon 6/0 is based on a 
6-sided polygon; 0 steps of 
rotation between the halves; 
even number of lanes.

Sphericon 6/0+ is like 6/0, 
but with an odd number of 
lanes.

Sphericon 6/0/H is hybrid 
built from half 6/0 and half 
6/0+.

Flexify can create all the 
distinct sphericons from 3/0 
up to 11/5. Where two 
sphericons are chirally 
equivalent, like 6/1 and 6/5, 
Flexify offers only the first 
one.

quatretat A curly projection.
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twistless rind
A developable shape. After 
work by D M Swart and 
Sebastien Perez-Duarte.

curvy cube
A developable shape. After 
work by D M Swart and 
Sebastien Perez-Duarte.

baseball
A developable shape. After 
work by D M Swart and 
Sebastien Perez-Duarte.

sprocket-4 A conformal shape.

sprocket-5 A conformal shape.
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daycare An asymmetrical developable 
shape.

short rind A developable shape.

Panini

Good for natural-looking, 
wide pictures with lots of 
straight lines. Stereographic 
horizontally, rectilinear 
vertically. Also called 
Vedutismo. 

YangTet

A quasi-curved-origami 
shape based on Oschene’s 
tetrahedral teabag box. 

To build:

- Render with Edges turned 
on

- Score along the internal 
edges

- Cut along the semi-circular 
marks on each side

- Slide the overlapping lens-
shaped parts together.
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YangOct

A quasi-curved-origami 
shape, and an octahedral 
version of the YangTet.

Build it like the YangTet.

Tribox

A quasi-curved-origami 
shape.

Build it like the YangTet.

Squarebox A

A quasi-curved-origami 
shape with a gnomonic 
projection.

Build it like the YangTet.
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Squarebox B

A quasi-curved-origami 
shape with a conformal 
projection.

Build it like the YangTet.

Squirclebox A

A quasi-curved-origami 
shape with a gnomonic 
projection. It’s based on 
work by Oschene and vitroid.   

There are no semicircular 
cuts. Just slide the two 
halves together, alternating 
the flaps.

Squirclebox B

A quasi-curved-origami 
shape with a conformal 
projection. It’s based on 
work by Oschene and vitroid.   

There are no semicircular 
cuts. Just slide the two 
halves together, alternating 
the flaps.
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Triskelion fat A developable shape.

Triskelion meso A developable shape.

Triskelion skinny A developable shape.

Triskelion plain A developable shape.

Triskelion 
straight A developable shape.
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Calliope A developable shape.

Clio A developable shape.

Euterpe A developable shape.

Thalia A developable shape.

Melpomene A developable shape.
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Terpsichore A developable shape.

Erato A developable shape.

Polyhymnia A developable shape.

Urania A developable shape.

Aglaia A developable shape.
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Euphrosyne A developable shape.

Naiaid A developable shape.

Thalassa A developable shape.

Despina A developable shape.

Galatea A developable shape.
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Larissa A developable shape.

Proteus A developable shape.

Triton A developable shape.

Nereid A developable shape.

Halimede A developable shape.
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Folding sphere

A curved origami pattern 
which folds into a sphere. 
The FOV slider control the 
number of segments; a 16 -
segment sphere looks nice.

Render it with Edges turned 
on. The straight edges are 
mountain folds, and the 
curved edges are valley 
folds.

After work by Jun Mitani, 
Oschene, and vitroid.

YangCube

A quasi-curved-origami 
shape.

Build it like the YangTet.

YangDodecahedron

A quasi-curved-origami 
shape.

Build it like the YangTet.
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YangIcosahedron

A quasi-curved-origami 
shape.

Build it like the YangTet.
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Input

Flexify can accept some of the above projections as input: equirectangular, 
mirror ball, polar, orthographic, cylindrical, ellipsoid, stereographic, Mollweide, 
gores:12, Robinson, Mercator, Lagrange, Hammer, Winkel Tripel, equal-area 
cylinder, gores:6, zenith & nadir, horizontal cross, vertical cross, and soccer. The 
following projections are for input only.

ellipsoid
A frontal view of a security 
mirror. The major axis to 
minor axis ratio is 1.18:1.

circular fisheye 
180°

A circular image showing 
a 180° field of view across 
its diameter.

fullframe 
fisheye 180°

A rectangular image 
showing a 180° field of 
view across its diagonal. 
The rectangle may have 
any proportions.

one cube face A square showing a 90° 
rectilinear view.
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tiling cube face

One cube face with all 
edges alike and 
symmetrical so that six 
tiles can seamlessly cover 
a sphere. You can make 
these with MakeCubeTile 
or MakeIsoCubeTile.

half-equi

The left or right half of an 
equirectangular image. If 
your input image is too 
big for Flexify, you can 
use this mode to process 
it in halves.

Nicolosi

A Nicolosi projection, a 
popular globular form 
found in antique world 
maps.

quarter-equi One-fourth the width of 
an equirectangular image.

mylar
The reflection in a silver 
balloon. The major axis to 
minor axis ratio is 1.55:1.
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gores: 12 radial
Twelve half-gores, a form 
sometimes used by the US 
Geological Survey.

spinner 360°

An image from a 
Lomography Spinner 360° 
camera. Crop the input so 
it’s 360° wide and the 
height spans from edge to 
edge of the film.

spinner guess 
width

An image from a 
Lomography Spinner 360° 
camera with unknown 
horizontal field of view. 
Crop the input so the 
height spans from edge to 
edge of the film. Flexify 
will try to guess the 
horizontal field of view.
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View

You can change the center of projection — the 
point in the input image that winds up at the 
center of the output.

Latitude moves the center of projection north 
and south.

Longitude moves the center of projection east 
and west.

Spin spins the view around the center of 
projection.

Flexify can set the center of projection 
automatically in three ways.

The reset button sets latitude, longitude, and 
spin to zero. This gets you back to the normal 
view.

The axis button sets latitude, longitude, and 
spin to multiples of 90°. This usually gives 
symmetrical-looking views.

The dice button generates totally random views.
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Retouching panoramas

Panoramas often need to be retouched by hand — the tripod needs to be painted 
out, or moving clouds need to be fixed — but it’s hard to paint properly on an 
equirectangular panorama.

Flexify can help. You can export, retouch, and then re-import panoramas. Three 
projections have matching output & input modes designed just for this task so 
you can round-trip an image.

zenith & nadir

Top and bottom cube faces. 
Good for hand-retouching 
the poles of a spherical 
panorama. Later, you can re-
import your changes with the 
zenith-nadir input mode. 
Flexify will then feather the 
edges a little to improve 
blending.

re-imported

horizontal cross

Cube faces in horizontal-
cross form. Good for 
retouching. Later, you can 
re-import your changes with 
the horizontal cross input 
mode. For best results, use 
the PSD export and choose 
4x3 image proportions.

vertical cross

Cube faces in vertical-cross 
form. Good for retouching. 
Later, you can re-import 
your changes with the 
vertical cross input mode. 
For best results, use the PSD 
export and choose 4x3 
image proportions.
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Polyhedra

Flexify has some projections that you can print, cut 
out, fold, and glue together to make a three-
dimensional printout of your panorama.

If you use a map of Earth as your input image, you can 
make a crude globe.

Tabs sets the width of “glue tabs” that make the 
polyhedron easier to glue together.

The Tab color button sets the color of the tabs.

The Faces checkbox shows each face of the 
polyhedron in a single color, to make it clearer how 
the shape should be folded together.

The Export Faces button offers three ways to export a 
polyhedron.

First, you can write a multi-layer Photoshop document 
with one face of the current polyhedron on each layer. 
Extra tabs will be added to each face so that everything 
can be glued properly.

Second, you can export 3D models in OBJ and STL 
format.

Third, you can export an equirectangular map of all 
polyhedron faces.

If your image is 32 bits per channel, then each face will 
be written to a separate document. If you export an 
OBJ model, its JPEG texture map will still be 8 bits per 
channel.

Pepakura Designer is handy for editing cut-and-fold 
paper models.
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Other controls

The Flip checkbox flips the input picture left-for right. If you’re starting with a 
mirror-ball photo, this will correct backward text.

The Sharpen slider makes the image crisper. Sharpening is done in the output 
image space, so you get the right result even where the picture is strongly 
warped.

The Background color button lets you choose a background color. If your color 
doesn’t show up, turn off Transparent Gaps.

The Preview menu improves the appearance of the preview at the expense of 
speed.

The Grid menu places a latitude-longitude graticule over the output.

The Transparent gaps checkbox tells Flexify what to do with undefined regions 
of the input. When this is checked, such areas appear transparent (or black if 
you’re working in the background layer). When it’s unchecked, they get a solid 
color halfway between the background and tab colors. Transparent gaps also 
makes the border, if any, around the result transparent.

The Indicatrix checkbox draws shapes which, on the image sphere, would be 
circles. It’s good for checking how distorted the output is.

The Anamorph checkbox produces a special distortion. Ordinarily the image 
sphere is meant to be viewed by an observer at its center; you could build globe 
with the image printed on the inside, and it would appear in correct perspective 
to an observer at the globe’s center. When checked, Anamorph moves the 
viewpoint to the surface of the sphere. You could then build a globe whose inner 
picture appears correct when viewed through a hole cut in its surface. This 
viewing point appears as a pinched singularity in Flexify’s output.

The Edges checkbox draws a black outline around each region of the result. It’s 
good for clarifying the fold lines for polyhedra

The De-halo checkbox guarantees that halos don’t appear along contrasty 
edges, but this comes at the cost of making the whole image slightly softer. It’s 
useful in HDR images where bad halos can appear at the edge of the sun or other 
bright lights.

Plus, % and minus buttons: if the selected image area is bigger than the 
preview, these buttons let you zoom in and out. You can move the preview by 
dragging it around; your cursor will turn into a hand.

Auto Preview:: When this box is checked, the preview 
automatically updates whenever you move any control. 
Turn it off if you want to save time.
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Load preset: Flexify comes with some presets, which 
are files containing settings. To load one, click this 
button and browse for a preset file.

Save preset: When you make an effect you like, click 
this button to save the settings in a file. 

Undo backs up one step.

Brick button shows settings for the brick sphere, 
explained below.

Glue lets you combine the result image with the 
original, instead of replacing it. The next-glue button 
advances to the next glue mode.

Send to iPhoto sends the result to iPhoto (on 
Macintosh).

Export to PSD renders the result to a .psd image file, 
which can have custom dimensions.

Little Planet quickly gives you the settings that make a 
little planet image.

Info briefly explains the controls.

Three more buttons:

OK  Applies the effect to your image.

Cancel  Dismisses the plug-in, and leaves the image 
unchanged.

Register Allows you to type in a registration code and 
remove the time limit from the demo.
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Memory dots

Although you can save your settings permanently to 
files, you can also stash settings in memory dots.

Click an empty dot to stash the current settings in it.

Click a full dot to retrieve its settings.

Hover the mouse over a dot to see what it contains.

Option-click to erase a dot on Macintosh.

Right-click to erase a dot on Windows.

If a dot is orange, Flexify’s currently using that dot’s 
settings.

Dots remember their contents until you erase them. If 
you’d rather make a temporary dot that forgets when 
you exit Flexify, control-click it. Temporary dots are 
square.

When you start Flexify, it puts the starting settings in 
a temporary dot. That way it’s easy to start over 
without exiting the plug-in.

On Mac, you can drag-and-drop settings files from 
the central memory well.

You can build a web page showing how the current 
image would look with every memdot setting. Just 
option-click (Mac) or right-click (Windows) on the big 
memdot image.
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Globemaking 

Flexify can warp maps into new shapes for making 
globes. You can use any of the polyhedron modes, 
explained above, to make faceted fold-together 
globes.

You can also make a conventional round globe. First, 
get a spherical object to use as a form. Traditionally, a 
plaster sphere is used, but a toy ball will do. It has to 
be exactly spherical: measure its girth in several places 
and verify that all measurements are the same.

Next, use Flexify to make “gores” — the lens-shaped 
strips of map that form a globe’s surface. Print these 
out so that the width of the gores is equal to the 
diameter of the sphere. Glue the gores onto the 
sphere, carefully making them conform to the curved 
surface.

The Tabs slider adds solid-colored “glue tabs” that 
make the gores easier to glue together. It also fattens 
the mapped part of the gores slightly too, so that you 
need not align them perfectly on the sphere.

The Tab color button sets the color of the tabs.

If you don’t want tabs, but do want the gores to be 
slightly fattened, set the tab color to the same as the 
background color.

Flexify can also accept gores as input and turn them 
into a conventional map. Use the input mode gores:12 
or gores:6.
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Brick spheres

Flexify can create plans for building an image sphere 
from Lego® bricks. Use the output mode called ‘brick 
preview’ to see what you can build.

To change settings, click the brick button. A new 
dialog box will appear.

Layers: To suit the proportions of the bricks, Flexify 
plans a sphere with a diameter 6/5 of the height. For 
best results choose a height that’s a multiple of 5.

Plates: Builds the sphere from 1/3 height plates 
instead of bricks.

Colors: The best input images have vivid colors and 
strong, simple shapes.

For output you can choose among 12 colors: black, 
blue, brown, green, dark grey, light grey, red, sand 
red, tan, white, yellow, and sand green.

Light grey bricks will represent any undefined regions.

You can make three kinds of output:

— a multi-layer Photoshop document where each layer 
of the document is the plan for one layer of the sphere

— an LDraw model

— a text file with counts for each color of brick.

In the Photoshop document, parts that aren’t visible 
from the outside are marked with black dots, so you 
can substitute other colors there. The sphere plan is 
hollow and just thick enough form a solid surface so 
you’ll need to build supports inside as you go.

The plan doesn’t specify exactly what bricks to use, 
just what colors go where.

There are some related links later in this document.
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Cube maps

Flexify can split a panorama into six cube faces. Some 
panorama viewers want this format, and it’s often used 
to make “sky boxes” in 3D action games.

Click the cube map button and a new dialog box will 
appear asking for the size of the faces. Flexify will 
write six Photoshop documents containing the cube 
faces.

Frequently asked questions

I want to make maps and globes with Flexify. Where can I find suitable input 
maps?

Here are some places to start looking:

NASA’s Blue Marble imagery

Virtual Terrain project links to many map sources

NASA Jet Propulsion Lab maps of most Solar System bodies

Ars Technica earth map

Living Earth maps of Earth, Moon, and Mars

Björn Jónsson’s planetary maps

LunarCell synthetic worlds

You can use Flexify’s polyhedron and gore modes to make cut-and fold globes.

How do I make a spherical photo without expensive special equipment?

Get a plain silver spherical Christmas-tree ornament and photograph it.

 

How do I improve photos of ornaments?

Panoramas made with the mirrored-ball technique always have a flaw at the 
point opposite the camera. You can either paint this out, or you can photograph 
the ball twice from two locations about 90° apart around the ball’s equator. 
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Unwrap both reflections; their flaws will be in two different places. Use the good 
part of one image to replace the flaw in the other.

Since the reflection in the ball contains the whole scene, the sun or another light 
source will probably appear in it, and this can cause your camera’s auto-
exposure to darken the whole picture. Avoid this by using a manual exposure 
setting appropriate for a typical part of the scene.

The best ornaments to use are blown-glass ones from eastern Europe, but there 
are other kinds of mirrors you can use:

Gazing balls. These are garden decorations originally popular in Victorian 
England, and they can be found at some garden-supply stores.

Safety/security mirrors. These are the dome-shaped mirrors sometimes seen at 
busy corridor intersections at airports and warehouses. These are usually not 
hemispheres but ellipsoids with proportions of about 1 : 0.85, so you should use 
the ‘ellipsoid’ input mode.

Large steel ball bearings. The makers of HDR Shop have hints on where to get 
them.

Hemispherical mirrors from “whole sky cameras.” These are hard to find since 
meteorologists now use fisheye lenses for sky photography.

Large steel or copper mixing bowls don’t give sharp reflections, but they are 
inexpensive and can produce soft, tinted views with streaky blurs around the 
highlights.

Using a mirrored ball you can make a wide horizontal view panorama with no 
flaw. Place the ball on the ground and photograph it from directly above; or hang 
it from something and shoot it from below.

Use a zoom or telephoto lens to get far from the mirror and minimize the size of 
the camera in the picture.

To enable a telephoto lens to focus closer, use it together with a close-up lens. 
That this will reduce depth of field, making focussing trickier.
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What is the difference between equirectangular and Mercator?

An equirectangular image shows the whole sphere, usually in a 2:1 wide 
rectangle. The north and south poles are stretched out to lines at the top and 
bottom, and the lines of latitude and longitude make a uniform grid of squares.

A Mercator projection shows most of the sphere, but not the poles or nearby 
regions, because the complete projection is infinitely tall. The lines of latitude 
and longitude form rectangles that stretch taller the further they are from the 
equator.

Although Mercator projections are notorious for making Greenland look as large 
as South America, they have two useful properties. They are conformal, which 
means angles are accurate within small regions. And they show lines of constant 
compass bearing as straight lines. These lines, known as rhumb lines or 
loxodromes, are useful in air and sea navigation, which is why Mercator maps 
are still used.
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So:

Equirectangular images are good for panoramas and spherical texture maps.
Mercator maps are good for sailing across an ocean.

 

How do I make a cylindrical QuickTime VR panorama?

Make an cylindrical projection, then turn it sideways so the bottom is on the 
right. Convert it with QTVR Make Panorama 2 (Mac) or VRMakePano (Windows). 
You can find more detailed instructions here.

How do I make a cubic QuickTime VR panorama?

Make an equirectangular projection that’s exactly twice as wide as it is tall, then 
convert it with MakeCubic PPC (Mac) or PanoCube (Windows).

 

What other panorama viewers are there?

Lots; click here for a list.

 

How else can I (ab)use Flexify?

Straighten out the horizon in panos shot off-level.

Warp an HDR lighting environment so it’s easier to paint out the tripod.

Use it on non-panoramic photos to make them weird.

Distort the same image twice or more in a row to make it weird.

Photograph safety mirrors and security-camera bubbles in public places. De-
warp the reflections to see what they see.

Extract a normal (rectilinear) view from the input.

Take a photo of a spherical object like an orange or the Earth and see what it 
would look like from a different point of view. Use orthographic input and 
orthographic output.

Make many-sided dice for role-playing games. Use only polyhedra whose sides 
are all the same shape; otherwise the die will be biased.

Make weird graph paper. Start with a blank white image and turn the grid on.
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What are some panoramic photo resources on the net?

Panoguide.com — info for beginner to semi-pro panoramic photographers

Panorama Tools  — software to view, create, edit and remap panoramic Images

Evermore QTVR links

International Association of Panoramic Photographers

Panoramic Network — galleries & info

Panoscan — high-end scanning cameras

Apple’s QuickTime VR developer tools

 

Where can I get Lego® info and bricks?

eBay — good for used bricks

BrickLink — extensive selection

Virtual Lego — a book about Lego® software

Lego Shop — the official source

LDraw — model-planning software

LUGNET — users’ group with extensive resources

Version history

Version 2.6.8

Adds YangDodecahedron and YangIcosahedron output modes, and spinner 360° 
and spinner guess width input modes. Faster drawing of all polyhedral output 
and best-quality output.

Version 2.6.6

Adds YangCube output and Ortelius oval input.
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Version 2.6.5

Adds the triskelion fat, triskelion meso, triskelion skinny, triskelion plain, 
triskelion straight, Calliope, Clio, Euterpe, Thalia, Melpomene, Terpsichore, 
Erato, Polyhymnia, Urania, Aglaia, Euphrosyne, Naiaid, Thalassa, Despina, 
Galatea, Larissa, Proteus, Triton, Nereid, Halimede, and folding sphere 
projections.

Version 2.6.2

Adds the YangTet, YangOct, Tribox, Squarebox A, Squarebox B, Squirclebox A, 
and Squirclebox B projections. Fixes the missing the offset in shift-lens; 
proportion problems when exporting unFish, and improper cropping of 6-clover. 
Basic multicore support for Windows.

Version 2.6.0

Adds the Panini projection. Fixes faint dark lines that could appear in HDR 
images when “dehalo” is turned off. 64-bit version for Windows. 

Version 2.5.2

Adds the sprocket-4, sprocket-5, daycare, and short rind projections. Fixes 
hairline gaps that can appear in the twistless rind. Fixes blank results when 
exporting some polyhedra to OBJ files.

Version 2.5.0

New output modes: zenith & nadir, horizontal cross, vertical cross, thirtysphere, 
devtet, conictet, geodesic spheres, sphericons, quatretat, twistless rind, curvy 
cube, baseball.

New input modes: six gores, zenith & nadir, horizontal cross, vertical cross, 
soccer.

Gores 3 of 12 output mode is now properly aligned when longitude = 0.

Option-click on the memdot preview now builds a web page showing how the 
current image would look with every memdot setting.

Version 2.4.0

Adds the tattoo 1 and tattoo 2 projections. Fixes improper results from 
exporting cube faces on Intel machines.
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Version 2.3.9

Fixes a case where the Mac version can fail to produce a a result after the user 
clicks OK.

Version 2.3.8

Adds the 3-incurvate, 4-incurvate, phenyl cross, anthracene, and conformal 
dodecahedron shapes. Fixes artifacts that can appear when “de-halo” is turned 
off.

Version 2.3.7

Fixes a crash that can happen on Macintosh PowerPC machines.

Version 2.3.6

Adds the shard and starburst projections. Makes the first preview appear faster 
in the Mac version.

Version 2.3.4

Fixes a case where the Register button may not respond.

Version 2.3.2

Fixes a crash that can happen on PowerPC Macs.

Version 2.3

Adds the waffle, trident, astercurve 5, astercurve 7, astercurve 8, trizag, shark 3, 
shark 4, sunburst, 2 cylinders, 3 cylinders, and Isle of Man projections. Adds 
exportation of equirectangular poly-face maps. Brick previews can have 
antialiasing. PSD export has a “same proportions as original” option. Text entry 
of settings. The Mac version has multicore support, drag-and-droppable 
presets, and a resizable interface.
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Version 2.2.5

Adds the pointy, shuriken star, calyx 3, calyx 4, calyx 5, and calyx 6 projections. 
Fixes cosmetic problems with the interface under Mac OS 10.5.

Version 2.2.4

Adds the square fish 1, square fish 2, and Gilbert globe projections. Improves 
the handling of input modes which have transparent areas or discontinuities. 
Changes the Gilbert projection so it reacts more usefully to nonzero latitude 
settings.

Version 2.2.2

Adds quick globe and equal squarea projections. Improves “best” mode results in 
strongly anisotropic regions. Removes speckled pixels that sometimes appeared 
on one edge of previews in “better” mode. Some polygonal projections now show 
colored faces better.

Version 2.2

Adds antialiased (smoothed) output and preview. New input modes: Hammer, 
Winkel Tripel and equal-area cylindrical. New output modes: cross, double 
Guyou, wide rect, semicircle, ellipse, Reuleaux 1, Reuleaux 2, Reuleaux 4, 
Reuleaux 8, octreleaux, zigzag, chevron, monozag, 3-malta, 4-malta, 5-malta, 
6-malta, Gilbert, stereo twice, stereo thrice, Adams diamonds, equal-area 
cylinder. No more missing graticule lines. Graticule slid over one pixel to the 
proper location. Added the Tissot indicatrix. Gores:6 output removed; use 
gores:multi instead.

Version 2.10

Adds the shuriken output mode. Fixes a Windows problem where the plug-in 
wouldn’t remember its registration when it was installed in one user account but 
activated in another. Fixes a Macintosh problem where the plug-in could have 
bad settings or crash when installed on a machine for the first time.
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Version 2.09

Adds 19 new output modes and the Lagrange input mode. Replaces gores:36 
with the more adjustable gores:multi. Improves the appearance near the poles in 
most conformal projections: no interrupted graticules, no top-to-bottom color 
wraparound.

Version 2.08

Adds new output modes: thorn levo, unFish, Lagrange plus, Adams 1, Adams 2, 
trecunx, quadracunx, quincunx, sexacunx, heptecunx. Smoothed out creases in 
thorn mode. Fixed poor antialiasing in the 4/12/24/60/70 views modes. Fixed a 
probLem where the latitude-longitude grid would sometimes not appear, and 
de-cluttered the grid near the poles. More memory dots. Windows PSD export 
can have a custom size. Mac presets have custom Finder icons.

Version 2.06

Adds new output modes: semistereo, thorn, Lagrange 3/4, squoculus, and box. 
Universal binary on Macintosh. More memory dots. Exported HDR files can be 
layered. Exported OBJ files fixed to work with Photoshop CS3.

Version 2.05

Adds exportation of PSD images with custom size; new grid option. New input 
modes are 12 gores: radial and Mercator. Fixes a problem under Windows where 
the software could crash on HDR images.

Version 2.04

Adds the equi tall projection. Fixes a problem where the software could forget its 
registration.

Version 2.02

Adds IPTC keywords and color profiles to all exported images.

Version 2.0

Adds 32-bit high-dynamic-range capability. Can handle images up to 30,0000 x 
30,000 pixels, given enough hard drive space. Adds the quarter-equi, Robinson, 
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and mylar input modes; rind 1, rind 2, rind 3, tunable ellipsoid, tunable egg, 4 
four views, 12 views, 24 views, 60 views, 72 views, and Robinson output modes. 
Memory dots, info button, exportation of 3D models. Changes ‘transparent gaps’ 
to make backgrounds transparent too. Equirectangular output is now always 2:1. 
Cube maps now always export to six separate files. Adds Anamorph and De-halo 
controls. Exported PSD files now have color profiles. The Mac version lets you 
use Adobe’s color picker.

Version 1.99

Adds the stereographic, hyperdouble, hypertriple, Mercator cross, Mercator star, 
and Lagrange projections. Fixes tiny flaws in the grid lines and adds a glue 
mode. Better previews in the file chooser. The Mac OS X version adds the iPhoto 
button.

Version 1.98

Faster. Adds the Mercator and umbrella projections.

Version 1.97

Adds the GID, oculus, triptych, tetraptych, and annulus projections; sharpening; 
transparent gaps; polyhedron edges; two new glue modes.

Version 1.96

Adds the dodo projection and face exportation.

Version 1.95

Adds the 6/12 gores projection, and Nicolosi, stereographic, and half-equi 
input. Works with 16-bit-per-component color.

Version 1.94

Adds the swoop projection and more glue modes.

Version 1.92

Recordable as a Photoshop action. Adds the beanbag projection.
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Version 1.9

Adds globe gore input, more brick options including LDraw; the star 3, star 5, 
and magnipolar projections; and six new glue modes. Improves globe gore 
output.

Version 1.86

Adds a button for creating cube maps. Adds a six-gore mode and changes gore 
shapes slightly for better results. Fixes the appearance of previews in presets 
from version 1.85.

Version 1.85

Adds two input modes: circular fisheye 180° and full-frame fisheye 180°. Fixes 
tabs on the ‘24 faces a’ shape.

Version 1.84

Adds Mollweide input and output, and icomap output.

Version 1.82

Adds more glue modes and fixes a crash that could happen when using the 
menus under Windows XP.

Version 1.81

Adds the ellipsoid input mode. Adds new glue modes: Color, Luminance, Linear 
Light, and Pin Light. Fixes the appearance of text in the interface when running 
under Mac OS X 10.2.3 .

Version 1.8

Adds the brick sphere.
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Version 1.75

Adds the spikeball. Fixes the sizes of the half-polar, Hammer, lozenge, and two-
circles projections, which were too small in version 1.7. Changes the tabs on the 
‘gore’ projections to simplify printing them at the right size.

Version 1.7

Adds the paperlock and Omnimax projections, and origami instructions.

Version 1.6

Adds the grid checkbox.

Version 1.5

Adds the ‘24 faces b’ shape.

Version 1.4

Adds the loop, two-circles, and balloon shapes.

Version 1.3

Adds the 12-, 24-, and 36-gore shapes for globemaking.

Version 1.2

Adds the 30-faces polyhedron shape; adds two new input modes, cylindrical and 
orthographic; and fixes a bug where some polyhedra would not display correctly.

Version 1.1

Adds eight new polyhedron shapes.

Version 1.0

The first public release.
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How to purchase

You can place an order online here. A secure server for transactions is available.

Questions

The software, documentation, and supporting materials are made by Flaming 
Pear Software. Answers to common technical questions appear on our support 
page, and free updates appear periodically on the download page.

Trouble with your order? Orders are handled by Kagi; please contact them at 
admin@kagi.com .

For bug reports and technical questions about the software, please write to 
support@flamingpear.com .

©2010 Flaming Pear Software
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